Basic Techniques for Creating PowerPoint Presentations

Produced by
The Skills Team
University Library
University of Hull
Setting the look of your presentation

Choosing a colour scheme
If you choose and stick to a colour scheme, it forces you to use a limited palette for your presentation and creates a cohesive look even if you change other elements.

- On the Design ribbon, click on the More button ( ) in the Variants section.
- Choose Colors.
- Select a scheme you like or think will be appropriate to your presentation.

Choosing default fonts
Choosing a default font will keep a consistency throughout your presentation whilst allowing you to have a slightly more interesting look than the standard Calibri.

- On the Design ribbon, click on the More button ( ) in the Variants section.
- Choose Fonts.
- Select from the list of fonts given.

  All the fonts in this list are suitable for the main text in your presentation (they are not too fancy and hard to read).

Note – you can override the default font for specific pieces of text should you need to.

Choosing a background
Backgrounds should be plain colours, slight textures or slight gradients. Do not choose anything too busy as it will interfere with the clarity of your slide content. If you choose a plain colour, it should be pale or dark, nothing in between. For many presentations it is perfectly acceptable to keep the background white.

- On the Design ribbon, choose Format Background ( ). This is also available by right clicking on the background of the slide.

  The Format Background pane will appear on the right of the screen.

- Select the type of background you require.
- If Solid fill, select the colour by clicking on the Color button ( )
- If Gradient fill, we recommend a simple two colour gradient:
  o Remove the middle two colour stops by selecting them and clicking the Remove button ( ).
  o Now select each of the end stops in turn and choose your colour using the Color button ( ).

  Choose two similar colours so that text will be equally readable in all areas of the slide.

- If Texture fill, avoid the ones that come with the program. If you have already found and saved some texture files you can select them here by clicking on File... Alternatively, choose the Online option and search for something like “blue texture” or “grey texture”
• You can change the intensity of all background colours/gradients/textures by using the Transparency slider. For a gradient you must set it for each colour stop.

• If you want the majority of slides in your presentation to use the same background settings, click the Apply to All button at the bottom of the pane.

Adding text to every slide (in the footer)
Often, a tutor will require you to display your module number and student number on every slide (some prefer it only on the title slide so do check). You can add it to every slide easily in the footer.

• From the Insert ribbon, choose Header & Footer.

• Check the small box alongside the Footer option. This allows you to type in the Footer box.

• Enter the text you want to appear on every slide in the Footer box.

If you want to put this information more prominently on your title slide, you may wish to check the Don’t show on title slide option so that it is not repeated.

• Click Apply to All.

Changing defaults for all slides
Some settings, for example the position of the footer, the colour of the default text need to be changed for all slides. That is where the Slide Master is used.

• On the View ribbon, select Slide Master. This shows the layout masters for each of the available slide layouts.

• Where the thumbnails are on the left side of the screen, scroll up and click on the larger Slide Master at the top of all the layout masters. This is very important if you want to affect ALL slides.

Changing Default text colour
• Click into the title area of the displayed slide master.

• Right click and use the small floating toolbar to change the text colour to a suitable one for your slide background.

As a general rule:

- Dark coloured background – use white text
- Pale coloured background – use black text
- White background – use dark coloured text
- Black background – use pale coloured text
• Do the same for the first and second level text.
  *You will never need to use more than second level text (and even this only rarely).*

**Changing the position of the footer**
If you want to move your footer to the left or right of the slide, you should do this here on the Slide Master so that you don’t have to keep doing it on each new slide.

• Delete the two small text boxes to the left and right of the footer as these are not needed (click on the dotted border of each box and press the **Delete** key on your keyboard).

• Drag on the border of the footer box (on the dotted line) to position the box to the left or right side of your slide (the box rather than the text within it).

• Click into the footer box and use Ctrl+L or Ctrl+R to align the text to the left or right of the box as appropriate.

**Closing the Slide Master view.**
• On the Slide Master ribbon, click the large red **Close Master View** cross (⨉).
  *You should be returned to your title slide with the text colours/sizes/fonts showing the changes made to the slide master.*

You have now set the basic look of your presentation. You can override the options on individual slides, but all new slides will use the settings you have selected.
Creating a title slide

The title slide is important as it sets up the feel of the whole presentation. It needs to include both the title and your own details and should always include a visual of some nature to add interest.

The title slide is the default slide format when you first create a new presentation.

It has two text boxes which are both centre-aligned in the middle of the slide.

The text boxes are not fixed, and you are free to change them as you need.

It is usually best to decide on your visual element before you change anything to do with the text boxes as this will affect your decisions.

All the procedures shown here for the title slide are applicable to any slide in the presentation and may be repeated in later parts of this document

Adding an image from a file

See page 8 for different ways to add images.

- On the Insert ribbon, choose Pictures. This will open a standard file navigation dialog box.
- Navigate to the picture file you want and select it.
- Click Insert. Your image will be inserted in the centre of the slide.

Moving and resizing images

Moving images

- With the image selected (you will be able to see handles around its edges) drag in the middle of the image (you should see a four headed arrow which indicates you are moving the image).

  Do not drag on the handles – this will reshape/resize the image rather than move it.

Resizing images

- Make sure your image is selected (you can see the handles) and drag on any of the corner handles.

  You need to drag diagonally – inwards to make smaller and outwards to make larger. A two headed arrow will indicate you are resizing rather than moving.

  Avoid the middle handles on each edge as dragging on these will distort the image leading to an unprofessional look.
Moving and resizing the text boxes

Although the text box position and size is decided by the template and slide layout you are using, you are completely free to change this on individual slides.

Moving a text box

- Click into the box so that you can see its border and handles.
- Drag on the border of the box *between* the handles (avoid the handles themselves).

  *The four-headed arrow will indicate you are moving the box.*

Resizing/reshaping a text box

- Click into the box so that you can see its border and handles.
- Drag on any of the handles around the border to resize or reshape the box.

  *The two-headed arrow will indicate you are reshaping the box.*

Change text format on a single slide

**All the text with a box**

- Click into the text box so that you can see the borders around the box.
- Click on the border of the text box

  *The flashing cursor will disappear from inside the box.*

- Change any of the text settings (font, size, colour etc) using the options on the **Home** ribbon.

**Specific words or phrases**

- Drag over the specific words or phrases you want to reformat.
- Change any of the text settings (font, size, colour etc) using the options on the **Home** ribbon.

  *Alternatively, right click on the selected text and use the options in the small floating toolbar that appears above the menu.*

Changing the background colour of an individual slide

Sometimes you want to change the background colour of a single slide rather than the whole presentation.

- Right click anywhere on the background of the slide and choose **Format Background**.

  *Make sure you do not click into a text box or on a graphic item – near the edge of the slide is best.*

- On the Format Background pane that appears down the right edge of the screen, select the colour or style you require.

  *It will change it for the slide you are on only unless you click Apply to All.*

Using the Eye dropper to select a colour from an image

- In the Fill Colour box on the **Format Background** pane, select **Eye dropper** from the drop-down list.
- Move the Eye Dropper icon over the image you want to pick up a colour from – use the very tip of the icon (bottom of it) to point to the required colour and click to pick it up.

  *The tip here is pointing to the colour that will be selected (shown in square)*
Some example title slides

Having an interesting title slide will set the scene for your presentation

Creating a new slide

- On the home menu, click on the words ‘New Slide’.
  
  This will open up a drop-down list showing the different slide layouts available.

- Select the layout style you need.

  If you click on the top-half of the New Slide button (with the image) it will create a slide with the same layout as the previous slide from now on.
Working with images

Please note this document does not take into account licensing restrictions – if you are giving any external presentations it is essential that you only use images that you have the legal right to use.

Inserting images
You have three main ways to insert images into PowerPoint:

1. From file – for if you already have the image saved somewhere on your computer.
2. From Online Pictures available within PowerPoint – for if you want a fairly standard image, often for use in diagrams.
3. Cutting and pasting from images found on the internet.

Inserting an image from file

- On the Insert ribbon, choose Pictures.
  *This will open a standard file navigation dialog box.*
- Navigate to the picture file you want and select it.
- Click Insert.
  *Your image will be inserted in the centre of the slide.*

Inserting Online Pictures

There are two ways to insert online pictures:

1. Use the Online Pictures option within PowerPoint which uses a Bing image search.
2. Search using Google Images and copy and paste the image (or download it and use the insert an image from file option shown above).

Using Online Pictures option

- On the Insert ribbon, choose Online Pictures.
  *This opens up a dialog box containing a Bing Image Search box:*

  ![Bing Image Search](Image)

- In the Search Bing box, type your search term and press Enter.
  *Your results will be returned.*
- In order to reference the image, you will need to go to the page it comes from to copy the URL. You can do this by clicking on the link at the bottom of each image (this appears when you hover over the image).
- Once you have copied the URL, return to PowerPoint (your Insert Pictures box should still be open).
- Click on the image to select it (the small box in the top left of the image will be checked).
- Click Insert.
  *Your image will be placed in the middle of your slide.*
- Paste the URL into the Notes section underneath your slide so that you have it for your references later (you can use the link to go to find the details you need for your on-slide citation too).
Using Google Image Search

- Go to https://images.google.com/
- Enter your search term in the search box and press Enter.
- If you hover over an image, it will tell you its dimensions.
  - Larger images (at least 1000 pixels in the first value) should be big enough to fill whole slides, other images should be at least 600 pixels in one dimension or they will be too small to use as anything other than icons.
- Once you find a suitable image, click on it to open the full image preview.
- Right-click on the large image and choose to Copy it (not Copy Link).
- Go to PowerPoint and Paste it onto your slide.
- Again, you will need to know the URL of the image for references so go back to your browser and use the button to go to the website it comes from and copy the URL.
- Paste this into the Notes section underneath your slide for future use.

Moving and resizing images

Moving images

- With the image selected (you will be able to see handles around its edges) drag in the middle of the image (you should see a four headed arrow which indicates you are moving the image).
  - Do not drag on the handles – this will reshape/resize the image rather than move it.

Resizing images

- Make sure your image is selected (you can see the handles) and drag on any of the corner handles.
  - You need to drag diagonally – inwards to make smaller and outwards to make larger. A two headed arrow will indicate you are resizing rather than moving.
  - Avoid the middle handles on each edge as dragging on these will distort the image leading to an unprofessional look.

Adding effects to images

There are several preset image effects that can enhance the look of your images.

- Double-click on an image to select it and display the Format ribbon.
- In the Picture Styles gallery, select the image style you require from the options available:
  ![Original image]
  ![Some image effects]
- If you wish to be more specific about the amount of shadow, reflection, soft edge etc. Then you can use the Picture Effects drop-drop down list to be select from more options.
Using SmartArt graphics

**Inserting the SmartArt**
One way to make your slides more visual is to turn basic lists into SmartArt graphics. These are a group of preset diagrams that come with PowerPoint. You just need to fill in the text.

- From the Insert menu, select **SmartArt**.
  
  *Note that the icon for this is also available in the centre of a new Title and Content slide when you create it.*

- Choose the type of SmartArt you require and click **OK**.
  
  *They are categorised to help you (down the left), and you can always change it later.*

---

**Adding your own text and images to the SmartArt graphic**

- A box should have appeared on the left of the SmartArt where you can add your text. Either type it in here or paste it from a bullet list if you already had one in your presentation.

  *If this box does not appear, you can bring it up by clicking the symbol at the edge of the graphic. Alternatively, you can type directly into the SmartArt shapes.*

Note that some SmartArt graphics require more than one level of bullet point, like this:

- Point 1
  - Sub point 1.1
  - Sub point 2.1
- Point 2
  - Sub point 2.1
  - Sub point 2.2

Use the tab key on your keyboard to move down a level in your list (and Shift+tab to get back to the original level).

Whenever you see a symbol it is indicating you need to click on the symbol to upload an image.
Formatting the graphic
The SmartArt graphic has its own tools – with its own Design and Format ribbons.

Changing the SmartArt Layout
Once you have your own text in the graphic, you can still switch the layout and see how it looks different ways.

- On the SmartArt Tools>Design ribbon, use the layout gallery to choose a different layout for your graphic. For example, these both use the same text:

With images added they could look like:

Changing the SmartArt Style
- On the SmartArt Tools>Design ribbon, use the SmartArt styles gallery to choose a different style of box if you wish:

It is not recommended that you use the 3D styles as these can be more difficult to read.

Changing the SmartArt Colours
- Change to some preset colour schemes using the Change Colors tool on the Design ribbon.
- Alternatively, click into a specific shape and use Shape Fill tool on the Format ribbon to change the fill colours.
Using the Drawing tools

PowerPoint’s drawing tools can be used to create your own diagrams and infographics. The drawing tools can all be accessed via the Drawing section of the Home ribbon.

Inserting shapes

- Select the shape you want to draw.
  *There are many more available than can initially be seen – use the More button ( ) to see the rest.*

- Move your mouse pointer to where you want the top-left of the shape to be.
  *Do not try to drag the shape from the ribbon to your slide. Just select, then move.*

- Drag diagonally down and right to draw your shape.
  *Note: if you hold the Shift key as you drag it will constrain to a regular shape (e.g. circle/square rather than oval/rectangle). If you hold the Ctrl key down it will draw from the centre out. You can do both too.*

- If necessary, edit the size and position as you would for an image (see page 8).

Editing the shape’s fill

- With the shape selected, use the Shape Fill button (in the Drawing section of Home ribbon) to choose a different colour as you can see on the right.
  *Note that you can also fill with pictures, gradients or textures using the same option.*

  - If you want to match the colour to something already on your slide (including areas of photographs), you can use the Eyedropper tool and click on the colour.
  - Pictures can be from file, searched for online or from the clip board (something you have copied).

Editing the shape’s outline

- With the shape selected, use the Shape Outline button (below the Fill button) and choose from the options shown on the right. This includes colour, weight and dash style.
  *Lines (rather than shapes) can also have arrow heads of various styles and sizes.*

Adding shape effects

- With the shape selected, use the Shape Effects button (below the Outline button) and choose from the options shown.
  *These include shadows, reflections, soft edges etc.*
Seeing the full options for formatting shapes

- Click on the small dialog launcher at the bottom right of the Drawing section of the Home ribbon.

  *This will bring up a pane down the right edge of the screen.*

- Clicking on the small triangle alongside an option (circled in red alongside Line above) will open the options for that setting.

- The options at the top can be clicked on to access the Shape/Line; Effects and Size/Properties.

  *The Text Options also give you access to text formatting options if you have any text in the shape.*

Adding text to shapes

- With a shape selected, type your words.

  *That really is it.*

- Text will default to be 18 point which is rarely big enough. Try to resize it to 24 point if possible.

Editing complex shapes

Some more complex shapes allow you to edit different aspects of their shape using small yellow glyphs. The example below is for an arrow:

- Draw an arrow.

  *You will see 2 yellow circles.*

- Drag the yellow circles to change the proportions of the arrow (width of stem, depth of arrowhead).

  *Many shapes have similar glyphs.*
Rotating and flipping shapes (also works for images)

Free rotation
- Drag on the circular arrow at the top of any selected shape or image.

90° rotations and flipping
- In the Drawing section of the Home ribbon, click on the Arrange button.
- That brings up the options below:
- Use the Rotate entry to get more options:

Aligning and Distributing
Shapes, images, text boxes can be aligned to each other or distributed evenly across the slide using the Align options.

- Select all the objects you want to align or distribute.
- From the Format ribbon, choose Align.
  
  The options on the right will appear:

- Select the option you require.